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Know your iPod.
By Adam Gillitt

A pple’s first iPod was 
released in late 2001, with a 
5GB hard drive for $399, and 
was only compatible with 
Macs with FireWire. The 

scroll wheel physically rotated 
around the central hub, and 
the buttons were located on 
an outer ring. In early 2002 a 
larger 10GB version debuted 
for $499 and introduced new 
PDA-
like 

features. 

The second generation of 
iPods was introduced in 
the middle of 2002 in 10 
and 20GB sizes, with basi-
cally the same case design, 
but with a new touch-
sensitive scroll wheel, PC 
compatibility and lowered 
prices: $299 for 5GB, $399 
for 10GB and $499 for 20GB. 

The first limited edition iPods, 40GB engraved with the 

signature of Beck, Madonna or Tony Hawk sold for $548. 

In Q2 of 2004, the third generation iPod bowed. The 

new case was rounded, with relocated controls that were 

touch-sensitive, and introduced the Dock connector, 

which allowed connections via either FireWire or USB 

2.0. Sizes and prices were 10GB for $299, 15GB for $399 

and 30GB for $499, Later in the year, the two larger iPods 

were increased in size to 20GB and 40GB respectively. 

Macworld, in January of 2004 saw the birth of the iPod 

mini, a business-card sized, 4GB capacity player, avail-

able in 5 colors for $249. The mini also introduced the 

click wheel, making the scroll wheel’s compass points 

double as clickable buttons. The 10 GB iPod was in-

creased to 15GB. HP reached an agreement with Apple 

to sell the iPod under their own brand name. 

http://www.apple.com/ipodmini/
http://www.apple.com/ipodmini/


Q3 of 2004 saw the introduction of the fourth 
generation iPod, with the clickwheel of the mini 
and the case design of the third generation. Only 
two models were offered this time, a 20GB for $299 
and a 40GB for $399. However, in Q4, the iPod 
photo was announced, with a color screen and 
the ability to store and display photos, in 40GB 
and 60GB sizes, for $499 and $599 respectively. At 
the same time, a special black edition of the 20 
GB iPod was released, with a red click wheel and 
the signatures of the members of U2, for $349. 

Expanding the family even further at Macworld in 
January, 2005, Apple launched the iPod shuffle, 

their first flash-based player in 512MB and 1GB sizes 
for $99 and $149. The pack-of-gum-sized players 
sported a spartan interface with no display and a 
simplified control pad. Users could choose to listen 
to their songs in order or shuffled randomly with 
a switch on the back. It connected to a Macintosh 
or PC via a built-in USB 2.0 plug. Equal parts music 
player and fashion accessory, the iPod shuffle also 
featured a lanayard in the USB connector cap, but 
ommitted the PDA features of its larger siblings. 

Apple maintains a useful page that will help you 
identify which iPod you have.

http://www.apple.com/ipod/
http://www.apple.com/ipod/
http://www.apple.com/ipodphoto/
http://www.apple.com/ipodphoto/
http://www.apple.com/ipod/u2/
http://www.apple.com/ipodshuffle/
http://docs.info.apple.com/article.html?artnum=61688
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So you own an iPod– 
what next?

By Ian Betteridge

(Note: This article mostly  applies to hard-drive based 
iPods. The new flash-based Ipod shuffle functions only as 
a music player and solid state drive for transporting files.)

E very gadget has 
a honeymoon pe-
riod, and the iPod is 
no exception. For a 
few weeks, or a few 
months, you and your 
iPod are inseparable. 
You’ll go everywhere 
together, do everything 
together, and delight 
in the joy of having 
all your music with 
you all the time.

What you might not 
know if you’re a first 
time iPod owner is how 
much more you can do 
with it. Apple’s little 

hard-drive-based music players are, in fact, tiny comput-
ers – and the iPod has become a platform which third 
party developers have built software and hardware for.

Apple itself has recognized this, by building in ap-
plications which take the iPod beyond playing music. 
If you’re using a Mac, you can also easily synchronize 
your Calendar and Address Book using iSync, software 
that Apple bundles with Mac OS X to synchronize 

not only the iPod, 
but also any Palm 
handhelds or Blue-
tooth-equipped mobile 
phones you have to 
hand. This lets you 
use the iPod as a kind 
of mini-PDA, carrying 
around contacts and 
appointments with 
you wherever you go.

But what if you’re 
using a PC running 
Windows? Is there 
a way you can take 
advantage of the cal-
endar and address 
book on your iPod? 
The answer is “yes” 



process, meaning you’ll need to back up anything 
that’s on their and re-sync your iTunes library.

Usefully, if you format the iPod as a Windows drive, 
the Mac will recognise it. But what if you want to 
keep it as a Mac formatted volume? Help is at hand in 
the shape of XPlay, a great piece of software which 
allows any Windows PC to read and write to a Mac-
formatted iPod. It’s also a good way to use an iPod 
with Windows 98 SE, which isn’t supported by Apple.

– although it’s not as easy as the Mac, you can get 
information from Outlook to your iPod in one of two 
ways. The easier option is to check out the Windows 
version of PocketMac iPod Edition, which will auto-
matically transfer your Outlook calendar and addresses 
to your iPod. However, you can also do it yourself, 
manually, if you want to save the additional money.

If you have an iPod, this ability to store all your 
personal data means you can leave your Palm at 
home. But, when travelling, you can also leave your 
travel alarm clock at home – thanks to the abil-
ity to use the iPod as for your wake-up calls.

Many users also forget that, at the heart of every iPod, 
there beats a miniature hard drive capable of storing 
gigabytes of data, and helpfully Apple has built in 
the ability to use the iPod as an external hard drive. 
This is a great way to get large amounts of informa-
tion back and forth between computers quickly, as 
well as an excellent way of keeping a mobile backup 
of important data when you’re on the road.

But what if you want to use your iPod in this way 
with both Macs and PCs? Because the two platforms 
use different formats for their hard drives, you’d 
expect that they won’t work together that well. Al-
though it’s easy to convert your iPod between Win-
dows and Mac formats, you lose all your data in the 



Car manufacturers have begun to include optional 
iPod connection kits in their cars, including BMW, 
Volvo and Mercedes, while car stereo manufacturers, 
including Alpine and Clarion, plan or have released 
car stereos that connect to and control your iPod.

You can control your iPod from across the room, 
using  Ten Technology’s NaviPod  or Griffin’s Air-
Click. Griffin has also released the BlueTrip, which 
connetcs the iPod to your stereo via bluetooth, and 
allows you to use the iPod as its own remote. 

If you’re using your iPod a lot— and you probably 
will— you’ll want some way of protecting it. There 
are many cases around to keep your player from get-
ting scratched, including high quality products like 
Bellagio Designs’ cases or Speck’s Skin series (with 
sizes including the new iPod shuffle), but if you want 
a simple and cheap way of cutting out the scratches 

Add it up.

O nce you’ve begun to discover how much more 
you can do with the iPod, you’ll want to invest in 
some of the many gadgets and add-ons which al-
low you to take things further. If you’re a digital 
photographer, for example, Belkin sells a widget 
which allows you to pull images directly from a 
Flash card onto the iPod for storage – and it doesn’t 
have to be an iPod photo. (Of course, you won’t be 
able to display your photos unless you are using an 
iPod photo.) Or, if you want to record audio notes on 
the iPod, Griffin’s iTalk remains a great solution.

Belkin, Griffin and others also offer a variety of prod-
ucts to connect your iPod to your car stereo. FM 
transmitters are particularly handy for listening to 
your iPod in the car, but be sure you choose one that 
allows you to select FM frequencies (like the Belkin 
TuneCast II) so that you can find stations in your area 
that are not already in use.  Griffin recently intro-
duced the SmartDeck, which maps the iPod’s controls 
to your car stereo controls. Or, you can get a simple 
cassette adaptor from your local electronics retailer. 
Many companies now offer in-car chargers  like the 
FlexDock from Ten Technology, as well as units which 
both charge the iPod and allow music to be played 
over the car’s speakers, like DVForge’s PodBuddy.

NaviPod, from  
Ten Technology.

http://www.bmwusa.com/ipod/
http://www.mbusa.com/main/container.jsp?/features/iPod/index.jsp
http://www.alpine-usa.com/products/leading_technology/leading_tech_kca-420i.htm
http://www.clarion.com/usa/products/multimedia/VRX755VD.html
http://www.bellagiodesigns.com
http://www.speckproducts.com/index.html
http://www.belkin.com/iPod/matrix/index.asp
http://www.griffintechnology.com/
http://www.tentechnology.com/
http://www.dvforge.com/podbuddy_main.shtml


There are other add-ons available, ranging from 
a combination laser pointer and flashlight from 
Griffin to arm-bands from Apple to firmly anchor 
your iPod during a rigorous workout. An upcom-
ing dongle called the JamPod that allows you to 
play your guitar along with the music through the 
headphones, while SendStation sells PocketDock 
adapters that allow for a variety of USB, FireWire and 
Line Out connections. You can find these and other 
useful add-ons on our iPod accessories page.

then products like TrendyGeek’s Pod Shields are a 
very good choice. But for the ultimate in protection, 
you’ll need to wait a while for H20 Audio’s SV-iPod 
– a case designed for surfers, skiers, and other ex-
treme sports enthusiasts that will protect your iPod 
from water while letting you listen to your music.

Whether you care about scratches or not, though, you’ll 
care about the quality of the audio coming out of your 
iPod – and this is one area where Apple hasn’t set the 
world on fire. Although the headphones that come with 
the iPod are adequate, they lack bass and – if you have 
anything but the perfectly shaped ear – tend to fall out 
at annoying moments. You could invest in a decent 
set of headphones, or in Apple’s own in-ear option, 
but the most cost-effective way we’ve seen of improv-
ing the audio from your iPod is Griffin’s EarJams, a 
small set of rubber caps for the bundled Apple phones 
which add bass and make them more comfortable to 
use. However, since all iPods have standard audio-out 
jacks, you are free to use any headphones you like.

If you prefer to hear your music out loud, several 
companies are now offering speakers with a dock incor-
porated to plug in an iPod directly-- some even charge 
the iPod while it is docked. Bose offers the SoundDock, 
JBL sells both the OnStage and OnTour, and Altec 
Lansing has come up with the inMotion series.

http://www.dvforge.com/jampod.shtml
http://www.sendstation.com
http://extremetech.shopping.com/xPP-MP3_Accessories-ipod~CLT-DNL01~linkin_id-3061001
http://trendygeek.com/
http://www.h2oaudio.com/products/
http://www.bose.com
home_entertainment/index.jsp
http://alteclansing.com/product_cat_portable.asp?region=northam
http://alteclansing.com/product_cat_portable.asp?region=northam


Apple iTunes 4.5  
iTunes Music Store.

By Troy Dreier

O ver the span of about a year, Apple’s iTunes 
Music Store has gone from being a concept to be-
ing the dominant player in online music retailing: It 

commands over 70 percent of the market, has sold 
200 million songs in its first year of operation, and 
now offers over 1,00,000 tracks.  Apple frequently 
updates its iTunes utility, letting buyers make bet-
ter use of the store and the tracks they purchase there 
(as well as the ones they rip from their own CD col-
lections). But while iTunes is still a top-tier player 
and store, the improvements in 4.5 turn out to be 
less interesting in practice than they are on paper.

The feature likely to 
get the most attention 
is iMix, a way for you 
to create song playl-
ists and then upload 
them to the iTunes 
store. Other users can 
then browse and even 
rate your playlists. It 
sounds like a good way 
for the store to add 
community features, 
something it sorely 
lacks compared with 
Napster 2.0 (our cur-
rent favorite online 
music purveyor). While 
it may be fun after 
future improvements, 

http://www.apple.com/itunes/store
http://www.apple.com/itunes/store
http://www.apple.com/itunes/download/
http://www.apple.com/itunes/download/


iTunes finally delivers jewel-case printing with this 
release. The feature is easy to use, but here again, cus-
tomization is lacking. You can print a “mosaic” insert 
with small images of the cover artwork for your CDs or 
a plain text insert. The mosaic inserts looks extremely 

professional, but 
there’s no way to 
adjust what you 
get. It’s a one-size-
fits-all option that’s 
leaves no room 
for creativity.

Apple ‘s iTunes 
Music Store offers 
clear navigation that 
makes finding songs 
as easy as shopping 
in a well-laid-out 
real-world music 
store. Downloads 
are high-quality 
128-Kbps AAC files, 
which to our ears 

sound nearly as nice as 160-Kbps WMA files. Songs 
you purchase are yours forever and can be played on 
three computers, transferred to an iPod, and burned 
to CD an infinite number of times (as long as the 
playlist a song is in changes after every ten copies).

iMix is less than thrilling so far. Looking at other 
people’s song lists isn’t all that fascinating, and 
there’s no way to post comments on mixes; all 
you can do is rate them from one to five stars.

Also missing the 
mark slightly is 
a new tool called 
Party Shuffle, which 
lets you generate a 
playlist of random 
songs. We love that 
it shows the last 
songs played and 
the songs upcom-
ing, and that it’s 
easy to add songs 
and reorder them. 
But the customiza-
tion options need 
work. You can 
select only one 
library or playlist 
where songs should 
come from and can opt to have higher-rated songs play 
more often, but that’s all. To be truly useful, Party 
Shuffle should offer more control over which artists, 
playlists, or genres should or shouldn’t be included. 



The catalog  now contains over 1,000,000 songs 
and includes content from all five major labels 
and over 200 independents (the service didn’t 
have any indie content when first launched). The 
store includes playlists of favorite songs compiled 
by celebrities like Moby and Sting. And in addi-

tion to music, you can browse 5,000 audio book 
titles from Audible.com to play on your iPod.

A pleasure to use, iTunes Music Store made search-
ing and finding songs the easiest among the three 
other online music services we tested. That said, to 



Apple is also changing the digital rights on purchased 
songs with this release. Users who buy songs on 
the iTunes Music Store can now play them on five 
computers (up from three), but can only burn a 
playlist to CD seven times (down from ten). So while 
iTunes 4.5 isn’t a must-have upgrade, it does enhance 
an already outstanding digital music package.

(iTunes current version is 4.7. Changes since this review 
include the ability to show duplicate tracks, support for 
AirPort Express and new iPods, almost a dozen interna-
tional iTunes Music Stores, and other performace tweaks.)

stay competitive, the store will need to add com-
munity features. Without them, it feels sterile—like 
a lovely, well-lit superstore after closing time.

Thankfully, iTunes Music Store is also a strong 
jukebox. You can rip CDs into AAC or MP3 formats, 
burn CDs, and create playlists (including smart playl-
ists, which add relevant songs as titles are added 
to your library). If several computers on your lo-
cal network are running iTunes, you can turn on 
sharing to see and play each other’s libraries.

Windows users with WMA song libraries will appre-
ciate a new feature that converts those tracks into 
AAC files (which can be played on iPods). It works 
well, but only on WMA tracks without digital rights 
management (DRM)—meaning that songs you’ve 
purchased elsewhere online can’t be reencoded. Au-
diophiles will love the new lossless encoder, which 
imports tracks with the same quality as uncom-
pressed CD audio but keeps file sizes reasonable.

New offerings in the iTunes Music Store include 
radio charts (which show what songs are hot on 
stations around the country), a dedicated music-
video section with an expanded number of videos, 
movie trailers viewable within iTunes, the abil-
ity to save the Music Store’s 30-second previews to 
your computer, and free weekly song downloads.



iPod Tips and Hacks.

Use Contacts and Calendar with Outlook 

• Reset Play Counts • Make a “Freshest 

Tracks“ Playlist • Create Gapless Music 

CDs • Go to Sleep and Wake to Your iPod 

• Run iPod Diagnostics • Keep Your Music 

CD Quality • Using iPod’s  AppleScripts •  

Converting an iPod from Windows to Mac 

and Back Again • Use your iPod  

as an External Disk Drive



2. In Outlook, find the contact you want to move 
to your iPod and open it.

3. Choose File > Export to vCard file.

4. In the “File name:” box, type the name you 
want the contact to have.

5. In the “Save as type:” box, choose “VCARD 
Files” from the pop-up list. Don’t click Save 
yet!

6. In the “Save in:” pop-up at the top of the dia-
log, navigate to your iPod.

7. In the file window, which now shows the iPod’s 
contents, double-click the Contacts folder.

8. Click Save.

The next time you disconnect the iPod, the contact 
you saved will appear in the iPod’s contacts folder.

The procedure for putting an Outlook calendar 
event on the iPod is similar. It goes like this:

1. Connect your iPod to your computer. Choose 
Start > My Computer to make sure you’re the 
PC can see your iPod.

2. In Outlook, go to the Calendar, find the item 
you want to move to your iPod, and open it.

Use Contacts and Calendar with Outlook.
By Scott Knaster

A pple is very magnanimous to Windows us-
ers when it comes to iTunes, providing Windows 
and Mac versions that are nearly identical. But 
that cross-platform policy does not extend to Ad-
dress Book, iCal, or iSync, programs that Mac users 
have for managing their contacts and calendar info, 
and then flowing that information to their iPods.

However, because the iPod uses standard formats 
- vCard for contacts, iCalendar and vCalendar for 
appointments - you’re in luck no matter which 
program you use to manage your personal informa-
tion. In this section, we’ll discuss the most basic 
tricks for getting contacts and calendar data to 
your iPod from the most popular Windows per-
sonal information manager: Microsoft Outlook.

You can get vCards and iCalendars out of Outlook, but 
it’s not particularly easy or obvious. There are sepa-
rate procedures depending on whether you want to 
export just a couple of items, or a whole bunch. Here’s 
how to put a single Outlook contact onto your iPod:

1. Connect your iPod to your computer. Choose 
Start> My Computer to make sure your iPod 
is visible.



3. Choose File > Save As.

4. In the “File name:” box, type the name you 
want the calendar event to have.

5. In the “Save as type:” box, choose “iCalendar 
Format” from the pop-up list. Don’t click Save 
yet!

6. In the “Save in:” pop-up at the top of the dia-
log, navigate to your iPod.

7. In the file window, which should be showing 
the iPod’s contents, double-click the Calendars 
folder.

8. At last, click Save.

You have now stored a single calendar event on your 
iPod. When you disconnect the iPod, go to Calendar 
and you should see your event on the appointed date.

This one-at-a-time stuff is OK for limited use. But 
what if you want to put a whole bunch of Out-
look items onto your iPod at once? Luckily, you’re 
not doomed to repeating this procedure over and 
over again for each item. Instead, there’s a hack 
for exporting multiple items all at once. This pro-
cedure works for both Contacts and Calendar 
items, although you can’t mix the two types in 
one export. Here are the steps for Contacts:

1. As before, be sure your iPod is connected, and 
that your PC knows it’s connected.

2. In Outlook, go to Contacts and select all the 
items you want. You can use shift-click and 
control-click to choose multiple items.

3. Choose Actions > Forward as vCard. This cre-
ates a new e-mail message with all the Contacts 
you selected converted to vCard format.

4. Address and send the e-mail to a trusted friend 
- like yourself. Although all the vCards are right 
there for the taking, there’s apparently no way 
to access them all at once except as a received 
e-mail.

5. Collect your e-mail in Outlook. When you look 
at the received message, you should see all the 
vCards as attachments.

6. Select the message that you sent with all the 
vCards. Choose File > Save Attachments > All 
Attachments. Note: if you use an e-mail pro-
gram other than Outlook to collect your mail, 
it might not have the Save All Attachments fea-
ture.

7. In the Save All Attachments dialog that ap-
pears, click OK.



6. Address the e-mail message to yourself and 
send it.

7. Collect your e-mail. Select the message you 
sent and nod knowingly at all the iCalendar 
attachments.

8. Choose File > Save Attachments > All At-
tachments.

9. In the Save All Attachments dialog, click OK.

10. You’ll see a file list for Save All Attachments. 
Find your iPod, then its Calendars folder, and 
click OK.

That’s it! You have now transported the appointments 
you selected in Outlook to the iPod’s Calendar.

8. Next, you’ll see a Save All Attachments file 
list. Navigate to your iPod’s contacts folder and 
click OK. 

You’re done - the contacts have been 
shipped off to your iPod.

If you want to export multiple Calendar items, 
Microsoft makes the steps very similar, yet sub-
tly different, just to keep us entertained:

1. Verify that your iPod is connected and visible 
under My Computer.

2. Go to the Outlook Calendar.

3. Most people have their Outlook calendars set 
up to display a graphical view. It’s easier to se-
lect and export multiple calendar items if you 
display your calendar in a list view. To see your 
calendar in a list view, choose View > Current 
View > Active Appointments.

4. Use shift-click and control-click to select mul-
tiple calendar items. Pick all the ones you want 
to export to your iPod.

5. Choose Actions > Forward as iCalendar. You’ll 
get a new e-mail message with all the appoint-
ments converted to iCalendar files.



Reset Play Counts.
By Scott Knaster

ITunes keeps track of a play count for each 
song in its library, a running total of the num-
ber of times a song has been played.

Whenever you play a song all the way through, its play 
count goes up by one. Playing it on your iPod counts, 
too: when you sync the iPod with your computer, the 
iPod tells the computer how many times the song was 
played, and the play count is adjusted accordingly.

Play count is one of the most powerful variables 
you can use when building Smart Playlists. When 
you create a Smart Playlist that selects songs 
by most or least often played, iTunes uses play 
counts to determine which songs to pick.

Sometimes it’s handy to be able to manipulate the 
play count directly. The easiest way to do this is to 
right-click (or control-click on a Mac) on a song and 
choose “Reset Play Count”. After a confirmation dia-
log, iTunes returns the track’s play count to zero.

This trick works just as well with multiple 
tracks. Select as many tunes as you want, then 
right-click on any of them and choose “Re-
set Play Count”. They’ll all be reset to zero.

Make a “Freshest Tracks” playlist.
By Scott Knaster

W hen you get new tunes from your favorite art-
ists, you’re probably excited to listen to it as soon as 
possible. But in the hustle and bustle of our stressful 
lives, we sometimes forget even pleasurable diver-
sions like listening to new music. iTunes can help you 
with this problem. Just create a Smart Playlist to keep 
track of your freshest tracks. Here’s how it’s done:

1. Choose File > New Smart Playlist. You’ll get 
the Smart Playlist dialog.

2. In the boxes that define conditions for the songs 
you want on the list, choose “Date Added”, “is 
in the last”, “30”, and “days”. You can adjust the 
“30 days” value depending on how aggressively 
you acquire new music.

3. Fine-tune your playlist. You can check the 
“Limit” box to keep the playlist below a chosen 
number of songs or length of time. If you want 
to make sure your “freshest tracks” playlist fits 
on your iPod, use the “Limit” to specify the 
number of megabytes or gigabytes of music 
you want.



 Create gapless music CDs.
By Scott Knaster

W hen iTunes imports music from a CD, it rips 
each track separately and leaves a gap between them. 
You can eliminate the gap between songs by us-
ing the “join tracks” feature before ripping a CD.

What happens to the gaps between tracks when you 
want to burn a CD? Take a look in iTunes prefer-
ences, on the Burning tab. You’ll see a promising 
setting labeled “Gap Between Songs”. This setting 
gives you some flexibility in burning audio CDs. 
You can use this setting to create CDs with no gaps 
between the tracks, but only in certain cases:

* You joined the tracks on the CD before import-
ing them.

* You’re burning a CD from an uncompressed 
format (AIFF or WAV) rather than compressed 
format (such as MP3 or AAC).

Unfortunately, if you create a CD from MP3, you will 
always get a gap between the songs. The gap is still 
there even if you use the “none” setting in Burning 
preferences, although it’s tiny and almost imper-
ceptible in many cases. The only way to ensure a 
gapless CD is to rip the CD with joined tracks, or 
in an uncompressed format (either AIFF or WAV).

4. Make sure “Live updating” is checked. This 
makes sure that tracks are kicked off the playlist 
when they get too old. Think of this as a “’fresh-
ness dating” system, like the date stamped on 
your milk. The dialog in Figure 5-2 shows what 
this looks like. Click OK, and you’ve got your 
playlist.

With a “freshest tracks” playlist, you can make 
sure you’ll never let those new tunes slip through 
the musical cracks. Any time we can make com-
puters do the remembering for us, it’s a plus.



Go to sleep and wake to your iPod.
By Scott Knaster

A fter a long night of dancing to the music in your 
iPod, you can use the same music and the same iPod 
as an alarm clock to wake you the next morning (or af-
ternoon). The iPod includes an alarm clock feature you 
can use to play music at a specified time. To set it up:

1. From the main iPod menu, go to Extras -> 
Clock.

2. When you get to the screen that shows the 
current time, go to Alarm Clock.

3. From the Alarm Clock screen, choose Alarm 
and press the iPod’s Select button (the one in 
the middle) until Alarm is set to “On.”

4. Choose Time and press Select. Use the wheel 
to specify the time for your alarm. Press Menu 
when you’re done.

5. Choose Sound and pick a playlist to be the 
soundtrack for your wakeup call. This only 
works if you’re going to have an external speak-
er attached to your iPod when it attempts to 
wake you up. Otherwise, it will start playing, 
but you won’t hear anything, which greatly re-
duces the alarm’s effectiveness. If you’re not 

going to have speakers attached, choose the 
Beep sound, which comes out of the iPod’s 
built-in speaker. 

If you have one, the Belkin Voice Recorder has 
a small built-in speaker you can use for making 
sure your alarm is actually alarming to you.

Not only can you use your iPod to wake you up, it’s also 
handy for helping you get to sleep. The iPod includes 
a sleep timer feature that plays for a specified length of 
time before shutting down. To set the sleep timer, go 
back to the Clock screen and choose Sleep Timer. You 
can then choose from sleepy times ranging from 15 to 
120 minutes before having your iPod shut itself off.

iPod to bed and iPod to rise - there must be 
a poem in there somewhere, or at least an 
Apple commercial. Pleasant dreams!



A. 5 IN 1

This runs several tests in a row: LCM, RTC, SDRAM, 
FLASH/CHECKSUM, and FIREWIRE/FW ID. (See 
below to find out what they do. Note that you have to 
press Play twice to get through LCM.) But the real cool 
stuff comes after the tests finish. On a 3G iPod, you can 
press buttons to make noises come out of the built-in 
speaker. Press Previous to hear the wheel’s clicking 
sound, Menu and Select to get two different long beeps, 
and Next for an effect that sounds a little like a Star 
Wars blaster. You can have a lot of fun walking around 
with your iPod, pressing buttons and staring intently 
at the screen as if you were doing something serious. 
The clicking sound makes a great fake radiation detec-
tor. Press Play to return to the Diagnostics menu.

B. RESET

This resets the iPod, just like pressing Menu and 
Play together, but slightly easier on your fingers.

C. KEY

This test is actually sort of a video game. You have 
to press all 5 buttons on the iPod within about 5 sec-
onds. As you press each one, its name appears on the 
screen. If you get them all in time, you see KEY PASS. 
If you’re too slow, you’re humiliated with KEY FAIL.

Run iPod diagnostics.
By Scott Knaster

T o enter the diagnostic mode on the iPod, first of 
all reset it. When you see the Apple logo, hold down 
Next, Previous, and Select. When the Apple logo 
goes away, release the buttons. You’ll see the coolest 
thing ever: a backwards Apple logo, as if you were 
inside the iPod looking out. If it’s a 3G, you’ll hear 
the iPod emit a little squeal, like you were pinching 
it. Diagnostic mode contains stuff used by engineers, 
technicians, and factory folks to test out the iPod.

The iPod mini is slightly different. For this model, 
again reset the iPod. When you see the Apple logo, 
hold down Select and Back. When the Apple logo 
goes away, release the buttons to see the famous 
backward Apple and get into diagnostic mode.

When you enter diagnostic mode, you get an ugly, 
non-iPod-looking screen with a list of eight diag-
nostic tests. Each test is marked with a letter, A 
through H. You might expect to use the wheel to 
select the tests, but it doesn’t work. Instead, use the 
Next and Previous buttons to move up and down the 
list. Press Select to run the highlighted test. While 
a test is running, press Play to return to the menu. 
If you scroll down past test H (or up past test A), 
you’ll see a second screen, items I through P.



D. AUDIO

When you run this test on a 3G iPod, you’ll hear 
a Pac Man-like drumming noise if you have an ex-
ternal speaker connected. On an older iPod, the 
screen will display AUDIO 0X00000001 DONE.

E. REMOTE

This one tests the iPod remote. It’s another game: 
you get a few seconds to press all the buttons on 
the remote. As you press each button, a rectangle 
appears on the screen in a position that corre-
sponds to the location of the button you pressed. 
If you don’t press them all in time, or you don’t 
have a remote connected, you’ll see RMT FAIL.

F. FIREWIRE/FW ID

This test checks out the iPod’s FireWire port 
to make sure it’s working OK. If it is, you 
get the comforting FW PASS message.

G. SLEEP

When you run this test, your iPod drops off to sleep. 
When you try to wake it, you might see the low bat-
tery icon, and the iPod might refuse to come back 
to life. If this happens, try resetting the iPod or 
connecting it to power. That should jolt it awake.

H. A2D

This one checks out the iPod’s analog to digital 
components. The test lists sometimes-cryptic 
names and results for several parts, which vary 
depending on the particular iPod model.

I. OTPO CNT

Run this test to play with the scroll wheel. “OTPO” 
is engineering-ese for the wheel – it was supposed 
to be “opto”, but the misspelling is charming, so 
why fix it now? When you run this test, move 
the wheel and you’ll see the iPod react by chang-
ing the big hexadecimal number on the screen.

J. LCM

This tests the iPod’s display. LCM probably 
stands for “liquid crystal monitor”. Run the test, 
then press Select to see a gradient pattern on 
the screen. Press Select again to see a giant 
plus sign. This plus sign refers to the positive ef-
fect the iPod has had on Apple’s bottom line.

K. RTC/CHG STUS

On older iPods, RTC tests something related to 
the iPod’s real-time clock, the one that knows the 
time of day. The value sometimes changes a little, 
but is always small. Is it related to the clock “drift”, 
as described in “Scary Time” in this chapter? I 
don’t know. It’s one of those iPod mysteries.



This item runs the hard drive test, without the cool 
animation you get for a disk scan, as described in the 
section “Use Button Combinations”. Scanning the disk 
takes many minutes. When the scan is done, you’ll 
see either HDD PASS or HDD FAIL. HDD means 
“hard disk drive”. “FAIL” means “Go get it fixed”.

P. RUN IN

This last item runs a series of tests over and 
over, until you press and hold Play. It seems 
designed to make sure the iPod is ready to 
go after it’s manufactured or repaired.

This test is replaced by CHG STUS (charge sta-
tus) on 3G iPods. CHG STUS displays values in-
dicating whether there’s anything connected via 
USB, FireWire, or the headphone port. It also ap-
pears to show if charging power is available.

L. SDRAM/USB DISK

SDRAM tests the iPod’s synchronous dynamic 
RAM. That’s the magic ingredient that fights skip 
protection and prolongs battery life: music is pre-
loaded into RAM and the disk drive spins down.

USB DISK tests something unknown and 
reboots the iPod into disk mode.

M. FLASH/CHK SUM

The FLASH test, called CHK SUM (checksum) 
on 3G iPods, examines the iPod’s flash ROM. The 
test finishes by displaying a hexadecimal num-
ber, probably a checksum to verify the ROM.

N. OPTO/CONTRAST

The OPTO test, on older iPods only, doesn’t seem 
to do anything at all. CONTRAST lets you fine-tune 
the screen contrast with the wheel, but any changes 
you make go away when you leave diagnostic mode.

O. HDD SCAN



Keep Your Music CD-Quality.
By Scott Knaster

T he music on a typical CD takes up 500 to 600 
megabytes of storage, or about 10 megabytes per min-
ute of music. If you stored music at that rate, it would 
consume a typical hard disk in a hurry. The develop-
ment of the MP3 format was a milestone in the brief 
and recent history of digital audio. MP3 provided a 
way to take a hunk of music, sift through it, remove 
most of the data, and yet end up with something that 
sounds quite faithful to the original version. This pro-
cess, called encoding, is what happens when you rip 
a CD with iTunes or any other program that creates 
MP3s. When an MP3 encoder gets through with a CD, 
it manages to produce music that takes up only about 
10% of its original size, or 50 to 60 MB per disc. A com-
panion program called (surprise) a decoder is required 
to play back the music. Programs like iTunes usually 
have both encoders and decoders (players) built in.

In 2003, when Apple opened the iTunes Music Store, 
iTunes added support for a new format called AAC 
(Advanced Audio Coding), which Apple says produces 
files that sound better than MP3s. When you buy songs 
from the iTunes Music Store, they come in AAC format. 
And by the way, AAC allows Apple to add some restric-
tions to music files, which you can’t easily do with 

MP3 files. These restrictions are the rules imposed by 
the iTunes Music Store: for example, tracks you buy 
can only be played on three different computers, and 
you can only burn the same playlist to CD ten times.

The hard part of encoding music is knowing which 
data can be thrown away without wrecking the sound. 
Over the years since the invention of MP3, encod-
ers have gotten much more clever at this key task. 
One way to make your files sound better is by keep-
ing more data and throwing away less. Both MP3 and 
AAC let you choose to make better sounding files by 
increasing the data rate, or the amount of information 
that’s stored for every second of music. The typical 
rate is 128K bits per second of music. You improve the 
sound quality by using the iTunes preferences set-
tings to increase the rate, all the way to a maximum 
of 320K bits per second. The higher the setting, the 
more disk space you use up. But if you have sensitive 
ears, you’ll probably be glad to make this tradeoff.

Even if you use the highest compression rate, some 
people can clearly hear the difference between mu-
sic played from CD and encoded (compressed) on a 
computer. If you’re one of those cursed with marvel-
ous hearing, rather than compressing your tracks, 
you can suck in the original full-length music from 
a CD to iTunes. All it will cost you is disk space.



Using Apple’s iPod AppleScripts.
By Scott Knaster

M ac OS X includes a cool technology called 
AppleScript that lets you automate common tasks 
in programs. Scripts written in AppleScript are 
little programs that you run by picking them out 
of the script menu in iTunes and other applica-
tions. We’ll talk about AppleScript much more in 
Chapter 6, in the iTunes part of this book. But 
there are some nifty AppleScript features for iP-
ods also, which is the focus of this section.

Apple provides the iPod scripts on its AppleScript 
site. Download them from that address and put them 
in the Scripts menu, by putting them in the Scripts 
folder, which you’ll find in /Home/Library/iTunes (if 
there isn’t a folder called Scripts there, create one). 
Most of Apple’s iPod scripts perform cool tricks with 
Notes. Here’s a description of what the scripts do:

Eject iPod. No, it doesn’t make your iPod physi-
cally fly through the air - it just unmounts the 
iPod so you can disconnect it. This one is espe-
cially useful when you hook it up to a keyboard 
shortcut, which you can do with the Keyboard 
& Mouse panel in System Preferences.

You can easily tell iTunes to import your CDs 
without compression, using the WAV or AIFF for-
mat. To do so, perform the following steps:

1.  Choose Preferences from the iTunes 
menu (Mac) or Edit menu (Windows).

2.  Click the Importing tab.

3.  Click the Import Using menu and choose WAV 
Encoder or AIFF Encoder

4.  Click OK.

From then on, whenever you insert a CD to be ripped, 
iTunes will simply copy the tracks from the CD without 
encoding them. The music will sound just like it does 
on CD, but it’ll take up about 10 times the disk space 
that MP3 or AAC files do. Once you have imported WAV 
or AIFF files, iTunes and iPod play them happily.

How much will it cost you to keep all your mu-
sic uncompressed? Not as much as it would have 
last year, and more than it will next year. In re-
cent times, hard disks have gotten much bigger 
and much cheaper. You can now buy big disks for 
less than $1 per gigabyte (Gb), which means you 
could store the uncompressed music from about 
500 CDs for about $300 on a 300 Gb hard disk.



Clipboard to Note. This is a super-simple, really 
quick way to add a note to your iPod. To use 
it, select the text you want and copy it, then 
switch to iTunes and run this script. The cop-
ied text turns into a note and goes onto the 
iPod. If your copied text is longer than the 4K 
limit imposed by iPod notes, no worries: the 
script will automatically chop up your text in 
multiple notes that are linked together.

Clear All Notes. Use this script to clear out all 
your notes in a hurry. The script also offers to 
remove all Notes subfolders.

List Notes. Run this script when you want to see 
a list of all your notes. You can select one and 
click Open to see the note’s text displayed in 
the TextEdit application. If you have a lot of 
notes, this can take awhile. Figure 2-9 shows 
an example of how this works.

MacCentral. This script opens the MacCentral 
web site using Safari and copies the first article 
into an iPod note. Because you get the source 
listing for the script, you can modify it for other 
sites too.

Printer Friendly. This one is useful, but kind of 
oddly titled. It grabs the text from the front 
window in Safari and makes a note out of it. It’s 

called “Printer Friendly” because it works best 
with pages that have few graphics or links, but 
you can use it with any page you point it at.



Use your iPod as an external disk drive.
By Scott Knaster

Y ou can use your iPod as a highly portable, large-ca-
pacity external disk drive. Make sure the “Enable disk 
use” box is checked in iPod Preferences in iTunes, and 
your iPod will show up as just another disk in the Find-
er or Windows Explorer. Once you’ve done that, you 
can use its excess capacity to store any files you want.

There is one drawback to using your iPod this way, 
or for any other purpose than simply getting music 
from iTunes. When your iPod is purely for music, 
and you’re using the automatic update feature, the 
iPod gets its songs from iTunes every time you con-
nect to the computer. All the tunes are stored on 
the computer and copied over to the iPod when 
you sync. This means, in effect, that the iPod is just 
a backup device for songs on your computer.

If that’s all you use your iPod for, the iPod’s con-
tents are completely disposable: you can reformat 
it, lose it, or cast it into the fires of Mount Doom 
without losing any data. Once you start keeping 
other information on your iPod, you have to be 
aware of what you’ve stored there, even backing up 
those files if you want to be sure not to lose them.

Converting an iPod from Windows to Mac 
and back.

By  Ian Betteridge

S uppose you take the plunge and swap your 
boring old Windows PC for a brand new iMac. Or, 
maybe you’re tempted to turn to Windows from 
the Mac. How do you change your iPod so you 
can use it with your new platform of choice?

If you’re converting from Windows to Mac, the first 
step is to download the correct iPod Software Up-
dater for your iPod: you can get the right version 
from Apple’s iPod download page. Run it while your 
iPod is connected via FireWire, and choose the op-
tion to Restore, instead of Update. Once this is fin-
ished, your iPod will be converted to Mac format, or, 
if you’re running Windows, to a Windows version.

Important note: converting your iPod to another for-
mat will erase everything on it, including both music 
and any files on there. Make sure you have a backup 
of anything important before you start, as there’s 
no way to recover anything once you’ve finished.



A Love Letter to an 
iPod mini.

By  Lance Ulanoff

L ate last year I wrote a column about the Macin-
tosh and its near brush with virus trouble. I received 
hundreds of e-mails telling me I was nuts (and worse). 
Buried in that column, though, was a little aside about 
my admiration for Apple’s industrial design prowess. 
No other technology company’s products have elicited 
as many “oohs” from me—and countless others. I 

thought the first iMac was adorable, and the second 
generation with its LCD panel was spectacular. 

That said, I do not own a Mac, and with much of 
my work focusing on the Wintel and PC industry, 
there’s little reason for me to do so. I have some 
envy though for those who do, especially when new 
Apple products come out. Most recently I found 
myself ogling the Apple iPod Mini. It’s sexier than 
the original—smaller and sleeker and it comes in 
a number of cotton candy colors. I know many 
people who own the original iPod, and they’d rather 
die than give it up. So while this smaller device has 



default player for all media types. That’s not help-
ful. Just let me play the one file and move on.

I can live with this minor annoyance, because 
every other part of my iPod Mini experience 
has been so splendid. Let’s break it down.

Awesome Design.
Everyone talks about the iPod Mini’s buffed casing 
and overall style, but a big part of its elegance is the 
interface and controls. The interface is small but ultra 
sharp and very easy to navigate from one level to the 
next. The ClickWheel just below the screen responds 
not only to pressure but to your finger’s movement. 
By gliding your finger around the dial, you can scroll 
up and down lists of music and increase or decrease 
the volume. I quickly learned how to use it without 
looking at the interface. I’d just reach down to my 
belt, where I’d attached the device, and adjust the set-
tings with a touch and a glide. Most of the other MP3 
players I’ve looked at are so poorly designed that you 
would think real people don’t even test them (check 
out the review of TDK’s wacky Mojo 1). All these but-
tons are virtually flush with the case. And even when 
I threw it into my backpack, I had only to set the Hold 
lock on top to keep the iPod Mini from accidentally 
turning on. I have heard some complaints about the 
style and quality of the included stereo headphones. 
I do not share them. They fit snugly (unlike most 

far less storage space (4GB compared with 20- or 
40GB), I thought it might be worth giving it a try.

The first thing I noticed about the iPod Mini is that 
it’s almost small enough to hide in one hand. There 
are only two edges to the whole thing: the top and 
bottom. The rest is a seamless aluminum shell that 
wraps around the body. It weighs (3.6 ounces)—about 
as much as an Altoids-filled tin—but still manages to 
feel substantial. It easily slips into my pants or shirt 
pocket or I can use the nifty plastic clip to attach it 
to my belt (there’s also an arm band accessory).

The beauty of this sultry product is only half the 
story. Apple has managed to craft a near flaw-
less combination of hardware and software; the 
software half, of course, being iTunes 4.5.

iTunes is, undoubtedly, the premier digital music 
application on the market today and, best of all, it’s 
free. I do have my small nits with it, mostly because 
the player, Apple’s QuickTime--like those from other 
media player companies (Real and Microsoft)--tries 
to take over all media content on your PC. This is an 
unfortunate by-product of the tooth-and-nail com-
petition among companies. I just wish Apple would 
take the high road--simply install iTunes and play 
MP3s and other digital music file formats within 
iTunes. If I double click on an MP3 file outside of 
iTunes, I do not expect to be asked to change the 



every other pair I own) and generate gorgeous, rich 
sound. I could even pick out the bongo-playing in the 
background of James Taylor’s “Shower the People”.

Connectivity and Compatibility.
iPods are now officially for everyone—Mac and Win-
dows users alike—and the iPod Mini never made 
me think twice about whether or not I could hook 
it up to a PC (the original iPods needed a firmware 
update). The package came with FireWire and USB 
2.0 cables. I do have a small issue with Apple’s USB 
2.0-only stance. No question that version 2.0 of the 
connectivity option is faster and better for download-
ing music to the Mini, but I think Apple failed to 
realize how many PC users have only USB 1.1 ports. 
(Editor’s Update: Apple states on its web site that 
some USB 1.1 systems will work with some iPod 
models, but also adds that this is not the most rec-
ommended configuration due to speed issues).

Easy, Easy, Easy.
After installing the iTunes software that ships with 
the player, I grabbed a stack of my CDs (of course, 
only those I own outright), and with iTune’s guidance 
I ripped 72 songs onto my hard drive. That process, 
which took over 2.5 hours for half a dozen CDs is per-
haps the most time consuming thing about listening to 

digital music on any player. Your alternative--and it’s a 
very good one--is to buy digital music at iTunes.com.

Pricing and Value.
At $249, the iPod Mini is considerably more expensive 
than flash drive-based players (which also have lower 
storage capacities) and $50 more than its nearest 
competitor, the Creative Nomad MuVo2. And for $200 
more, you can get 10 times more storage space in a 
standard iPod. I’d still opt for the Mini, though. The 
original iPod looks bulky by comparison, and the No-
mad is sorely lacking in sex appeal. Four gigabytes is 
still enough for around 350 songs at full quality(three 
times more than that at a lower bit rate), and that’s an 
excellent starting point for any digital music newbie. 
I thoroughly disagree with anyone who says that a 
128MB flash drive is adequate for digital music. You 
can fit just 45 high-quality songs on such a device.

Rugged, Dependable Performance.
I’ve already dropped the iPod Mini a couple of times; 
once it slipped out of my hands and another time I 
was trying to detach it from the belt clip and after 
pulling a little too hard the device popped out and hit 
the floor. Apple needs to rethink that design a little 
bit. In both cases, the iPod Mini came out largely 
unscathed--some scratches, but nothing major. I’m 
also impressed with the device’s antiskip technology, 



eyes lock on the TV set. She’s got a serious itch for 
one—this from a woman who has never uttered the 
words “want” and “technology” in the same sentence.

In my estimation, it’s time for other music player 
manufacturers to stop messing around, buy a few 
iPods (Mini and original) and analyze them top to 
bottom to understand why they’re so good and every-
thing else is so average. Is it that hard for Creative, 
Dell, and others to hire decent industrial designers?

I do have one small suggestion for this otherwise ex-
ceptional device. I would love to have an iPod Mini 
that supports AM/FM radio. The popular radio disc 
jockey who I listen to every morning regularly runs 
10-minute commercial breaks. I don’t want to switch 
stations. Instead, I’d love to just flip between the radio 
broadcast and my MP3 play list on the iPod Mini. I 
understand that it could be difficult to fit the radio an-
tenna and circuitry inside the already compact space, 
but perhaps Apple can make a slightly larger model, 
add $25 to the price, and voilà! It’s a Combo-Pod.

Now, that’s a device I’d buy for myself and gladly give 
as a gift.

which lets me literally run up and down a flight of 
stairs without even a hint of playback trouble. Anyone 
who tells you to steer clear of hard-drive–based players 
and stick with the no-moving-parts flash-drive mod-
els because of playback issues on the former is just 
plain wrong (at least in the case of the iPod Mini).

Hidden Extras.
I love that I can have the iPod Mini double as a 
very simple PDA. It can hold Microsoft Outlook 
contact info (up to 1,000 contacts from any info 
manager that can export vCards, including Out-
look and the Palm OS), schedule information (and 
sound alarms on due dates and times), and notes. 
It even has some cute games on it like Brick (a 
Breakout knockoff), solitaire, and Parachute.

Women Love It.
The original iPod was a hit with many tech-savvy 
women I know, and its popularity should only in-
crease since the iPod Mini was designed to appeal to 
women who may not be very comfortable with digital 
music and electronic devices. I know Apple got it 
right, because when I showed the iPod Mini to my 
wife and put the headphones on her ears, I saw some-
thing in her eyes I’ve never seen there before: techno 
lust. I could tell she wanted one of these things. Now 
when a commercial comes on for the iPod Mini her 
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both defaults could be changed via settings. iTunes is 
incapable of displaying file types, and the volume and 
playback controls were somewhere between balky and 
inoperative. iTunes was also agonizingly slow; rip-
ping a CD at 192 Kbps with error correction took 53 
minutes. Musicmatch did this in about 15 minutes.

The iPod Mini’s new click wheel, which integrates 
the four buttons with the scroll wheel, is actually 
easier to use than its predecessor. The iPod Mini 
can recharge from its charger or from the USB cable. 

Unfortunately, neither of the iPod Minis 
we tested could match Apple’s claimed 
8-hour battery life; we got a decent 7 
hours, 10 minutes on our best run.

The dock is a useful accessory, and the 
arm band is great for exercisers. The 3.4-
ounce iPod Mini has more EQ selections 
than any other player, and it carries over 
the games, calendar, and other goodies 
from the original iPod. You can browse 
for music by artist, album, song, genre, or 
composer and set up your own playlists.

The iPod Mini, with accessories, costs 
almost as much as the full-size 10GB 

iPod, but we don’t care. If you want cost-effec-
tive, get the Creative Nomad MuVo2. If you 
want premium, get the Apple iPod Mini.

Apple iPod mini.
By  Bill Machrone

BOTTOM LINE: A smaller, lighter iPod with 4GB 
storage. The standard by which all other personal 
audio players are judged.

PROS: Excellent ergonomics, large storage for small 
player. CONS:Won’t play WMA, no FM or voice 
record.

T he Apple iPod is the player by which 
all others are judged, from the packaging 
to the cables to the feel of the controls. 
The iPod Mini’s screen, though smaller 
than that of the original iPod, still makes 
you wonder why other manufacturers can’t 
produce displays this readable. The con-
trols do exactly what you expect, and the 
iPod Mini does the right thing even when 
you don’t expect it: turning on when you 
plug in the headphones, for example.

USB 2.0 makes downloads to the player quick 
and painless. But thrilled as we are with the 
player, we are not similarly charmed by Apple 
iTunes. It ripped more slowly than Musicmatch and 
other managers, it insisted on playing a CD while we 
ripped, and it defaulted to the AAC encoder, although 



Apple iPod.
By  Bill Machrone

BOTTOM LINE: The Apple iPod still has the easiest 
interface to use and is still the most stylish player. 
The price is friendlier, and the player is a millimeter 
thinner than previous iPods—all welcome improve-
ments that (again) make it the player to beat.

PROS: Thinner. Cheaper. Better battery life and con-
trols. CONS: Still no onboard FM or recording.

Y our first glance at the newest Apple iPod is 
likely to cause a double-take. Is it a white Mini? 
Where are the buttons? As soon as you touch it, 
your fingers confirm what your eyes were trying to 
tell you: Apple has grafted the control surface from 
the Mini onto its mainstream iPod, making the sur-
face a little larger in the process. Most buyers will 
agree that this is good news. And all buyers will 
agree the price drop across the iPod line ($100 less 
for the top-end 40GB model) is also good news.

iPod historians will note that the first-generation iPod 
had tactile buttons arranged around the touch wheel. 
Now the touch wheel is the buttons: When you press 
the forward, back, play/pause, and menu quadrants 
of the circle, you get a tactile click. The only thing 
Apple might have done better (for the Mini, too) is 

to provide an orientation dot so you can find “up” 
without looking when the player is in your pocket.

Although its height and width are the same, the new 
iPod is a millimeter thinner than its predecessor. 
The weight, however, remains the same, as does the 
chrome-plated back and the size of the screen. The 
new model, like the Mini, now charges from the USB 
connector as well as from its power plug. And speaking 
of power, Apple claims 12 hours of battery life, and we 
measured 11 hours 20 minutes in our tests—far and 
away the best battery life we’ve measured for an iPod.

There’s a welcome new main menu entry, Shuffle 
Songs. With it, we could easily shuffle-play whatever 
songs or playlists we had currently selected, with-
out menu-diving to turn on the feature. Although 
this feature isn’t unique to the iPod, it’s handy and 
well exposed in the interface. The effect of ran-
domly shuffling a playlist is akin to being tuned 
to your personal radio station: you don’t know 
what’s coming next, but you know you’ll like it.

We were eager to try Apple Lossless, the company’s 
new compression codec. Although it does not compress 
files nearly as much as the MP3 codec, it promises 
much greater fidelity. The new players have the codec 
built in, and the iPod Updater will install it on older 
iPods. We loaded uncompressed WAV files and losslessly 
compressed versions of the same files, then subjected 



files, but we could easily see the lower frequency re-
sponse and we could hear the compression artifacts at 
lower bitrates. If you plan to drive high-quality speakers 
at home (rather than ear buds on the go), we highly 
recommend the new codec for maximum fidelity.

If you like audio books, you’ll like the new feature 
that can speed up or slow down playback without 
changing the pitch of the speaker’s voice. Unlike 
the Creative Nomad Zen Xtra, the iPod’s tech-
nology works only for voice, not for music.

The new iPod comes in 20GB and 40GB versions, 
and you’ll still have to buy third-party add-ons to 
get FM reception or recording. But the iPod has 
become a platform, and Apple counts over 200 ac-
cessories with more arriving weekly, giving the 
iPod expandability other players can’t match.

This latest iPod is incremental progress. If your cur-
rent iPod works for you, there’s no need to dump it on 
eBay and buy a new one. But if you haven’t yet joined 
the cult of iPod, the improvements and lower prices 
mean your patience will be handsomely rewarded.

both the original and the compressed files to our audio 
spectrum analyzer. We were unable to detect a differ-
ence, even though the compressed files were a third 
the size of the WAV files. MP3 files made from the same 
WAV files were half the size of the losslessly compressed 



Apple iPod photo.
By  Bill Machrone

BOTTOM LINE: Apple retains the iPod’s famous 
ease of use and applies it well to digital photos, 
but with some odd limitations. If you want pri-
marily a music player with the added ability to 
see and show photos, too, you’ll be thrilled. But 
digital photographers will wish for more on-the-
road-friendly features.

PROS: Color screen, photo album display, and TV 
output give the iPod a vibrant visual side. Navi-
gation through albums and photos is quick and 
easy. TV output is excellent. Can synchronize 
and load new pictures automatically. Music fea-
tures remain the same—which is to say excellent. 
CONS: Cannot view JPEGs uploaded directly from 
a camera, only those loaded from a PC. Only one 
computer can update the photo database. Cannot 
zoom in or pan on photos. Album thumbnails are 
very small.

O ne of the theater’s most enduring slogans is “Leave 
‘em wanting more.” And that’s exactly how we feel 
about the new Apple iPod Photo. On the one hand, it’s 
still the music player to beat, now with a color screen 
and easy-to-use photo-viewing features. But while we 
enjoyed the performance, we were left wanting more.

In addition to its familiar music duties, the iPod Photo 
stores and displays photos—thousands and thousands 
of them—on its 40GB ($499 direct) or 60GB ($599) 
hard drive and 2-inch color screen. Options in the 
new iTunes 4.7 let you synchronize the images in 
a specific folder, so that your photos are always up 
to date. It can also turn collections in Adobe Photo-
shop Album 2.0 or Photoshop Elements 3.0 into iPod 
Photo slideshows—a nice touch for hobbyists who 
have committed their photo libraries to those apps.

With the new color screen, Apple omitted a brightness 
or contrast control, 
but you can still 
adjust the auto-off 
time for the back-
light. We found the 
display to be just 
a bit dimmer than 
we would have pre-
ferred, and the color 
balance is slight-

ly shifted towards the red, but not objection-
ably so. (Oh, and thanks to the addition of 
color, the solitaire game is finally playable.)

You can arrange your photos in albums, though the 
album view is fixed in a 5-by-5 image grid that yields 
thumbnails approximately 3/16 of an inch high by 1/4 



is to say excellent. One addition: You can now 
view album art on the Now Playing screen.

Odd, minor limitations keep the iPod Photo from be-
ing a killer implementation. You can’t zoom in or pan 
around your images, and you can’t rotate photos; all 
adjustments have to be made before you download 
the images. If you want to store full-resolution pic-
tures that can be transferred to another computer or 
printed, you have to select that option in iTunes. If 
you forget, you’ll wind up with low-res images on the 
unit’s hard drive that lack full-resolution counterparts.

Also, the iPod Photo insists that only one com-
puter can be its source of photos. If you connect it 
to another computer it will ask you if you want to 
replace all of the images currently on the iPod with 
the images currently on the computer. There is no 
way to add to the photo database other than add-
ing photos to the “home” machine and updating the 
iPod. Likewise, digital photographers can still use 
the Belkin Digital Camera Link or a card reader on 
the road to offload images to the iPod Photo, but you 
will not be able to display those images on the iPod 
Photo (since they do not pass through iTunes).

As a music player, the iPod Photo is still virtually 
unassailable. But in the growing arena of portable 
multimedia players, it is not king of the hill. For 
example, the svelte Archos Gmini 400 matches the 

of an inch wide. It 
can be difficult to 
distinguish one im-
age from another, 
especially when they 
have similar subjects 
or backgrounds. But 
navigating through 
the images is a joy. 
Click on a thumbnail 
to make it full screen, and you can quickly—and we 
mean quickly—scroll forwards of backwards through the 
library by running your thumb around the scroll wheel.

The iPod Photo stores images in an internal database 
in a resolution suitable to its 220- by 176-pixel screen 
or to a TV screen (if you connect the included audio-
video breakout cable or use the S-Video connector on 
the provided docking base). Slide show settings allow 
you to control the amount of time that each slide is 
on the screen, turn on a wipe transition, and select 
one of your playlists as a background music source. 
The TV image is sharp and stable, and Apple claims 
15 hours of music playing or 5 hours of slide show 
viewing from the rechargeable lithium ion battery.

Musically, the iPod Photo is identical in per-
formance to the fourth-generation iPod, which 



iPod Photo’s music abilities, trumps it as a photo 
viewer/storage companion, and handles video to boot.

That said, for users looking for a great mu-
sic player that also delivers the ability to store, 
view, and display photos, the iPod Photo is the 
latest in this line of must-have devices.

Apple AirPort Express.
By Troy Dreier

BOTTOM LINE: If you need to set up (or extend) a 
wireless network and also have an iTunes music 
collection, the AirPort Express is a must-have ad-
dition. It works easily and flawlessly.

PROS: Gives you an 802.11g wireless network and 
a way to stream iTunes music to your stereo in one 
tiny, affordable device. Setup is wizard-driven and 
should be painless for most users.

CONS: You can only play music at either the PC 
or the connected stereo, not both simultaneously. 
Unlike full-fledged media hubs, there is no way 
to control the streaming music when you’re away 
from your PC.

W hile the Apple-watchers were busy speculat-
ing what product the company would release next, 
Apple confounded them all with a product type 
that no one has seen before: Apple AirPort Express 
Base Station with AirTunes. Think of it as a wire-
less multifunction device. In addition to being an 
extremely compact 802.11g wireless access point, it 
also lets you stream iTunes-resident music from your 
PC to your stereo, extend the range of an existing 
wireless network, and even share printers wirelessly. 

http://www.apple.com/airportexpress/
http://www.apple.com/airportexpress/


lessly from their PC 
to any audio receiver 
or powered speakers. 
To set it up, simply 
plug the AirPort 
Express into a wall 
outlet near your ste-
reo (or another audio 
device), connect an 
audio cable between 
the AirPort Express’ 
line-out jack and the 
input of your sound 
source (Apple sells 
a $39 Stereo Cable 
Kit, though any stan-
dard audio cable will 
work), and run the 
simple setup wizard.

When you next 
open iTunes, 
you’ll see a pop-
up selection menu in the lower right corner of the 
screen that lets you choose where your music will 
play, either at the PC or at the connected stereo. 
(iTunes will only play it in one location at a time, 
so you can’t get sound from your computer and 

Maybe you don’t need all of those functions, but if 
you need even just two of them, the $129 (direct) 
cost of the AirPort Express is money well-spent.

The first thing you’ll notice about the AirPort Ex-
press is its excellent design, an Apple hallmark. 
The unit isn’t much larger than an iPod (3.7 by 3.0 
by 1.1 inches) and plugs into a wall socket directly 
with no power cord. It’s a breeze to carry when trav-
eling (it weighs 6.7 ounces), offers both WPA and 
WEP security, and can handle 10 users at once.

Use the Ethernet port to connect the AirPort Express 
to your cable or DSL modem, and you have an 802.11g 
access point with a range of 150 feet. Because of its 
small size, the AirPort Express has only one Ethernet 
port, so you can’t connect a second Ethernet cable 
(such as to a PC on your wired network). But by us-
ing the included software, you can easily set it up as 
a second base station on an existing wireless network 
to boost the range. Apple will only certify that this 
works with its own AirPort base stations; indeed, it 
didn’t work with a Linksys router in our testing.

If this were just another (albeit more compact and 
more user-friendly) wireless access point, we’d be end-
ing this review here. But Apple has gone a step further 
with AirTunes: the AirPort Express used in conjunc-
tion with Apple iTunes (both the Windows and Ma-
cintosh versions) to let users stream their music wire-



your stereo simultaneously.) The streamed tracks 
are uncompressed and sound rich and full.

If that weren’t enough, the AirPort Express also 
has a USB port for printer sharing. Any comput-
ers on your wireless network will automati-
cally have access to the connected printer.

The AirPort Express worked flawlessly in our test-
ing, proving itself easy to set up and use no matter 
what the purpose. It was smart enough to prevent you 
from sending audio streams to it from two sources; it 
notified us that the device was already in use when 
we tried to send a data stream from a second system 
running iTunes. It was also smart enough to know 
(and alert us) when speakers weren’t plugged in.

Some may lament that the AirPort Express isn’t a 
full-fledged media hub—letting you play and man-
age your PC-resident media files remotely—such 
as the products we’ve tested from Creative Labs, 
D-Link, Prismiq, and a couple dozen others. The 
biggest drawback of the AirPort Express is that you 
can’t control the music playback (or see playlist and 
track info) from the room where you’re listening to 
the music; you have to go to the PC on which iTunes 
is running to do any of that. But if you view the Air-
Port Express as a no-hassle portable access point 
that also lets you play your iTunes music collection 
elsewhere in the house, you won’t be disappointed.

Griffin EarJams.
By Ian Betteridge

EDITOR RATING: •••••

I f there’s one criticism that comes up about the 
iPod over and over again, it’s the headphones. 
Like most phones of their type, the standard iPod 
headphones deliver a tinny sound that leaks out, 
and they fail dismally at the task of blocking out 
the sounds around you. The first thing that any-
one who’s more concerned with sound than looks 
does is go out and buy a replacement set.

Apple’s answer to this of course would be for you to buy 
a set of its in-ear phones, which utilize rubber pieces 
which fit inside your ears, delivering a better level of 
bass, and some degree of noise cancellation. However, 
at $39, it’s an expensive purchase when you’ve already 
spent upwards of $249 for the iPod itself, and means 

throwing away a perfectly 
good set of phones.

EarJams, from Griffin 
Technology Inc, are an at-
tempt to bridge the gap be-
tween the default phones 
and Apple’s in-ear replace-
ments. They consist of 

http://www.griffintechnology.com/products/earjams/


PocketMac iPod Edition.
By  Ian Betteridge

EDITOR RATING: •••••

H ow many gadgets do you commonly carry 
around with you? A mobile phone is pretty much a 
given. Of course, you’ll probably have your iPod with 
you most of the time. Perhaps there will also be a 
digital camera lurking in your pockets. And you may 
even have a PDA somewhere about you as well.

Even though the devices themselves are small, once 
you start carrying them all around you’re going to 
need either large pockets or a bag. Far from look-
ing cool, you’ll look like some kind of alpha nerd.

The solution is to combine as many of the devices 
into one as possible, and, thanks to its flexibility 
and huge amount of storage, the iPod is ideal for 
taking on some of the load. It already has a calen-
dar, address book, and notes, which means that you 
can effectively get rid of your PDA, but the features 
in the iSync plug in are somewhat basic, and of 
course are limited to Apple’s own applications. If 
you use Microsoft Entourage, you’re out of luck.

Enter PocketMac for iPod. Its maker, Information 
Appliance Associates, has carved itself a success-
ful niche in synchronising Mac-based information 

small plastic caps which fit over the ends of your regu-
lar iPod ear phones, and attach to rubber plugs similar 
to those from the Apple in-ear phones. The whole 
assembly then fits into your ear, and there are three 
different sizes of plug for different sized ear canals.

In use, they work remarkably well, at least as well 
as the $39 Apple phones. We found the phones had 
good bass, blocked out noise well, and fitted snugly, 
although of course as each ear is individual how 
well they fit will depend on your ears. But the best 
thing about them is the price: $14.99, less than 
half that of the Apple in-ear phones, and includ-
ing a carrying case to protect your headphones.

Overall, EarJams are a great little solution for 
those who simply can’t live with the sound of 
the regular Apple ear phones, but don’t want 
to spend a lot of money on replacements.

http://www.pocketmac.net/ipod.html


with devices that don’t normally talk to Macs, such 
as the Pocket PC, and the aim of PocketMac for iPod 
is clearly to plug another gap that Apple has left.

PocketMac first and foremost acts as a conduit be-
tween the iPod’s calendar and address book and 
Entourage, working via an iSync plug in. This means 
that it works in tandem with any other devices you’re 
using, as well as synchronising with a .Mac account 
if you have one. This is important, as it removes 
a lot of the potential for conflicting schedules.

However, PocketMac goes much further than just act-
ing as a conduit between the iPod and Entourage: it 
also synchronizes documents – including Word, RTF, 
and PDF - and email. As there are no native document 
reading applications on the iPod, it cleverly breaks 
the documents into 4KB chunks and displays them 
in the iPod’s Notes application. Although this means 
that the product is limited to recent iPods which 
feature this, it’s a clever solution to the problem.

Of course, this means there are a couple of limita-
tions. You can’t author or edit documents, as you 
could on a real handheld. Long documents can be 
awkward to read on the iPod’s small screen, and al-
though the program does a good job of working with 
4KB chunks, linking them together in a fairly seamless 
way, it can till be difficult to read a long document.

PocketMac for iPod makes probably the best job 
that can be made of turning the iPod into a PDA. 
But what really makes it an essential buy for any-
one wanting to stretch their iPod is the price: 
$23.41 is a small price to pay for what it can do. 
If you’re an Entourage user, or simply want to 
do more with the iPod, it’s well worth buying.



yet seen. Anapod integrates with Windows Explorer, 
allowing you to directly drag and drop audio files on 
to the iPod from any folder on the PC. Uniquely, it 
supports conversion of audio files from formats that 
the iPod doesn’t understand – such as Ogg Vorbis, 

Anapod Explorer.
By  Ian Betteridge

EDITOR RATING: •••••

ITunes is a great piece 
of software for playing 
MP3’s, with one of the 
most accessible interfaces 
built, but it’s not for every-
one. On Windows in par-
ticular, it looks somewhat 
out of place, and Apple’s 
efforts to turn iTunes into 
a truly Windows-style 
application have been 
minimal at best. And, 
of course, if iTunes isn’t 
your preferred MP3 play-
er, you’re simply going 
to be out of luck when it 
comes to using the iPod.

Enter Anapod Explorer, 
which is the nicest and 
most comprehensive 
piece of Windows soft-
ware for getting the most 
out of the iPod that we’ve 

http://www.redchairsoftware.com/anapod/


FLAC, or unprotected WMA – into MP3, so you don’t 
have to worry about what format your music is in.

However, copying doesn’t have to be a manual process. 
Anapod’s SpeedSync feature allows you to designate 
any number of folders as being synchronised to the 
iPod, so that all the files within them are transferred 
over whenever the iPod is connected to your PC. 
What’s more, Anapod supports creating play lists 
directly within Windows Explorer, simply dragging 
tracks into and out of the play list at will. If you have 
pre-existing play lists created in any of the popular 
formats by applications such as WinAmp, you can 
also just drag the play list directly on to the iPod, and 
have all the tracks on it automatically downloaded. Of 
course, this is a two-way process: drag a play list from 
your iPod to the PC, and Anapod creates a new folder 
and copies all the tracks in that play list to the PC.

And Anapod Explorer does more than music, too: 
you can copy over all your contacts from Outlook 
with a single click, as well as creating iPod notes di-
rectly by typing on your PC. There are some other 
nice features too, which allow you to play the music 
on your iPod across a network, from any machine 
which supports MP3 streamed over HTTP, even allow-
ing you to play your music through a web browser.

Our only problem with Anapod Explorer came 
when occassionally it would refuse to recog-

nize the iPod. However, within less than a week 
the software was patched to fix this issue - and 
with the product being patched on average ev-
ery two weeks, bugs tend not to last for long.

Overall, if you’re using an iPod with Windows and you 
want to do more than iTunes is capable of, or you 
simply want the freedom to use your iPod in a different 
way, then Anapod Explorer is for you. Had this been 
$50, we would have thought it was decent value: at 
$25, it should be an essential purchase for anyone who 
can’t get their head about the way that iTunes works, 
or just wants more flexibility when using their iPod.



or Windows Me, you’ll need a product like XPlay 
in order to use your iPod with your computer.

What’s more, the latest version of XPlay adds some 
convenient features, which will appeal to some. 
The product now converts unprotected Windows 
Media files on the fly into MP3s when you copy 
across to the iPod, although this requires that you 
have MP3 creation software installed. The inter-
face under Windows XP is smooth, clean, and easy 
to use, integrating well with Windows Explorer.

XPlay is an impressive piece of software, both for its 
power and more than anything for its simplicity. For 
Mac users who want to use their Mac-formatted iPod 
with a Windows machine, it’s an ideal solution that 
just works – and at $29.95 it’s easily affordable too.

XPlay 2.0.
By  Ian Betteridge

EDITOR RATING: •••••

F or a brief period back in the dawn of iPod his-
tory, the product was effectively only for those happy 
few with Macs. iTunes, Apple’s excellent music ap-
plication and conduit to the iPod, was Mac-only, 
and iPod’s could only be formatted as Mac-native 
HFS+ drives. Unsurprisingly, some companies 
saw this as an opportunity – and in prime position 
was Mediafour, which already made MacDrive, an 
excellent piece of software that allowed Windows us-
ers to work with Mac formatted drives. Hence, the 
creation of XPlay, a piece of software based on Mac-
Drive which allowed users to copy songs direct to a 
Mac-formatted iPod from any Windows machine.

The natural question is whether there is any need 
for XPlay, now Apple has created iTunes for Win-
dows and iPods can be formatted in Windows-native 
formats. The answer, thanks to XPlay’s evolution 
into XPlay 2.0, is definitely “yes”. For example, if 
your primary computer is a Mac and you want the 
convenience of using a Mac-formatted iPod, yet oc-
casionally need to use the player with a PC, XPlay 
is an ideal solution. And, if you use Windows 98 SE 

http://www.mediafour.com/products/xplay/


Belkin Media Reader.
By Scott Knaster

I f you’re a digital photographer, you probably know 
the hassle of running out of space for pictures on 
your camera. It’s not like you can just carry a few 
extra rolls of film around with you – CompactFlash, 
SmartMedia, and the like are too expensive for that. 
Off-loading your photos to a computer is one solu-
tion, but you probably don’t want to drag a laptop 
around with you when you’re out taking pictures.

To solve this problem, you can get various portable 
hard disk solutions for storing your photos. But you 
already have a portable hard disk with abundant 
space – it just happens to be a music player too. So 

the folks at Belkin have given your iPod yet another 
job: digital photo storage. All you need is a box to 
read the photos and move them to your iPod. Bel-
kin Media Reader for iPod does the job for you. 
The Media Reader is a little bigger than a standard 
iPod and has slots for six different media types:

CompactFlash types 1 and 2

SmartMedia

Secure Digital (SD)

Memory Stick

Multimedia Card (MMC)

If you have a digital camera, it almost certainly 
uses one of the media types accepted by the Bel-
kin Media Reader. That’s one of the great features 
of this product: you don’t have to worry about the 
competing standards when deciding whether this 
reader will work for you. Just make sure your cam-
era uses one of the six supported types, which is 
nearly a sure thing, and you’ll be compatible.

To use the Media Reader, you open the nifty sliding 
door that protects the media slots, then put in your 
card. Connect the reader to the iPod’s dock connec-
tor. The iPod reacts by asking if you want to import 
photos from the media card. If you say you do, the 
photos are copied over while you watch a progress 

http://catalog.belkin.com/IWCatProductPage.process?Merchant_Id=&Section_Id=201526&pcount=&Product_Id=158350
http://catalog.belkin.com/IWCatProductPage.process?Merchant_Id=&Section_Id=201526&pcount=&Product_Id=158350


TrendyGeek Pod Shield.
By Ian Betteridge

Editor Rating: ••••

T he iPod is a design classic. No matter which model 
you have, it’s a pleasure to look at and use, thanks to its 
combination of smart good looks and simplicity. Yet it’s 
also prone to being scratched, especially if – like most 
people – you keep it in a jacket pocket most of the time.

The solution of course is to get a case for it, and 
there are many cases which fit the bill. From metal 
to the finest leather, you can enclose your iPod in 
the kind of variety of materials that put a high-class 
clothes shop to shame. Yet the problem with every 
case we’ve ever seen is that, once enclosed, your 
iPod no longer looks like an iPod. It goes from a 
design classic to something that’s hidden away, al-
most as if you were ashamed of its good looks.

However, if you want to protect your iPod without 
having to hide it away, TrendyGeek has a solution in 
the shape of its Pod Shields. These are simple, easy 
to fit plastic protectors for the metal back and screen 
of the iPod, which are design to soak up the scratches 
of everyday life. To say they’re simple is understating 
it: they require no glue, clinging to the iPod via static 
alone, and are cut to fit all fourth generation iPods 

screen on the iPod. Copied photos are stored by 
roll number. Once the photos are copied over, you 
can delete them from the media card so you can go 
take more award-winning photos of rocks and dirt.

Once the photos are in the iPod, what can you do with 
them? You can get information about them, such as the 
number of pictures in a roll and the type of media they 
were stored on. Once you reconnect to your computer, 
you can copy the photos over by using any software that 
imports digital photos, such as iPhoto, or you can copy 
them manually by looking in the cryptically named 
DCIM (digital camera images) folder on the iPod.

One thing you can’t do with the photos, unfor-
tunately, is look at them on your iPod. The iPod 
screen graphics capability is limited, and there’s no 
software support for showing images on the screen. 
Maybe this feature will show up in a future iPod.

The Belkin Media Reader for iPod works with 3G 
iPods. It’s sold at Apple stores, including the on-
line store, and many other places for about $100.



snugly, wrapping around to cover the sides and bottom 
with a cut-out for the dock connector port. Each pack 
comes with three back and three screen pieces, allow-
ing you to replace them when they become marked.

Fitting takes about ten seconds, and could be easier. 
The fact that they’re cheap too – around $12.99– makes 
them a very good solution for anyone who wants 
to protect the iPod without having it covered com-
pletely. Our only minus point was that, because of the 
iPod is slightly curved at the top, the back protector 
won’t quite fit flush to the iPod – something which 
could lead to the protector peeling off every now and 
then. However, given that you can simply smooth 
it back into place, this isn’t much of a problem.

Newer Ultra High Capacity 2100mAh battery
By  Ian Betteridge

EDITOR RATING: •••••

I f early adopters of the iPod have found out one 
thing, it’s that the battery life of Apple’s portable 
music player tends to diminish radically with time. 
If you bought an original iPod on the first day of 
its release and have used it regularly since, you’re 
likely to struggling with a battery life that’s per-
haps shrunk to less than an hour – something 
which makes the product more or less useless.

Of course, you could send it away to Apple and 
have the battery replaced. However, doing this is a 
relatively expensive, so it’s no surprise that several 
third parties have begun to offer battery upgrades 
which can be fitted by you. At much lower cost. One 
of these companies is Newer Technology, a name 
that will be familiar for its Mac processor upgrades. 
What’s more, its Ultra High Capacity 2100mAh bat-
tery delivers around 20 hours of battery life to any 
first or second generation iPod, for less than $40.

Fitting a battery to the iPod is one of those things 
which is much easier to do than you’d expect. Tak-
ing the case apart is simply a matter of sliding one 
of the plastic tools supplied down the crack between 



plastic and metal parts along the side and bottom of 
the player. Once this is done, you need to ease the old 
battery away from the drive underneath, retaining the 
two adhesive pads which hold the battery in place. 
Then detach the battery from the small cable which 
powers the iPod, and fit the new battery, using the old 
adhesive pads. Clip the metal back of the iPod back 
into place, and that’s it – the new battery is fitted.

We tested the battery by fully charging the iPod 
then leaving it on to play continuously until it was 
totally depleted, three times. Using a random set 
of songs including both short pop tunes and longer 
classical pieces, we found the Newer Tech battery 
delivered between 18 and 21 hours of battery life 

– a considerable improvement over the 40-60 min-
utes that the original battery had been managing.

Overall, the Newer Ultra High Capacity 2100mAh 
battery is the most cost-effective way of getting more 
out of a first or second generation iPod. If it were $50 
it would be a bargain: at less than $30, it’s excellent 
value for money. Even if you’re still getting a couple 
of hours of battery life out of an old iPod, it’s worthy 
spending the money simply to watch the faces of 
friends with the latest model as your two year old 
machine eclipses the “mere” 12 hours of battery life 
they’re getting. The battery is available through OWC.

Newer has added a battery replacement for third  
generation iPods, the NuPower High-Capacity  
850mAh Lithium-Ion battery, priced at around $25, also 
available from OWC.

http://eshop.macsales.com/Catalog_Item.cfm?ID=7157&Item=NWTIPOD210012
http://eshop.macsales.com/Catalog_Item.cfm?ID=6943&Item=NWTIPOD8503


Digital Audio Primer.
By  Jason Cross

I t seems as though there are more digital music 
players on the market now than grains of sand on the 
beach. Flash memory continues to drop in price and 
the electronics necessary to make a portable digital 
music player are increasingly commoditized. The re-
sult is a flood of affordable digital music devices from 
brands both large and small. This year will see the 
release of a slew of new digital media adapters— de-
vices that pull audio, video, and pictures off your 
PC and display them on your TV. Some will even be 
built into DVD players or TiVo-like video recorders. 
With all these new devices for playing digital music, 
it looks like the compact disc’s days are numbered.

Even if we don’t throw out our CDs, it’s more likely 
than ever that we won’t actually listen to them. In-
stead, we’ll pull the songs off, storing them on our PC 
or portable music player as compressed digital audio 
files. As the years roll on, more and more music will 
be purchased online in digital form. Most of us al-
ready have a lot of digital audio in our lives (beyond 
simple CDs), but the amount of it is set to explode.

So now let us go over digital audio terms and tech-
nologies. Most of us know a bit about the different 
formats and terms, but the world of digital audio 

is enormous and ever-evolving. What follows is 
a list of common and useful terms, their defini-
tions, and a description of some of the more popu-
lar and interesting digital audio formats. There’s a 
lot of ground to cover so let’s jump right in.

When you come across two geeks talking about digital 
music, it can sound an awful lot like they’re speak-
ing in another language (much like listening to a 
baseball fans). There’s a sea of terminology to wade 
through but much of it is purely academic and not 
really useful to typical consumers. Here are a few of 
the more common terms you should understand to 
get the most out of your digital audio experience.

Codec: Any time digital audio is mentioned, this word 
gets thrown around. It’s a shortening of compressor/
decompressor— an algorithm used to compress data 
and then decompress it again. Some codecs are imple-
mented in software, some in hardware, and some are 
limited in their functionality. A portable music player 
may have a “codec” that only decompresses data, for 
example. However, it’s common in the digital media 
world to call any algorithm that deals with the com-
pression and decompression of audio data a codec.

The process isn’t necessarily symmetrical— it often 
takes longer to compress a digital music file than to de-
compress it for playback. Decompression is less CPU in-



sionals seeking to archive large volumes of audio 
but now large hard drives are cheap and drive-based 
portable players with lots of storage are abundant, 
so lossless codecs are increasingly relevant to end 
users that want the best possible audio fidelity.

The following image shows the difference between lossy 
and lossless compression. We took a clip from the Fel-
lowship of the Ring soundtrack and encoded it in two 
formats: 
Windows 
Media 9 
Lossless 
and MP3 
at 128 
kilobits 
per sec-
ond. The 
original 
clip was 
10.3MB, 
which 
was cut 
down to 
6MB with 
the loss-
less co-
dec— not 
even a 2:1 

tensive, which is why tiny players with very low power 
processors are fine for playing back compressed music.

Compression Ratio: Simply put, this is the ratio 
between the size of the original uncompressed au-
dio clip and its compressed version. If an audio 
clip is 20MB in its native uncompressed form and 
1.8MB as a 128k MP3 file, then that file has a com-
pression ratio of 11:1 (typical of 128k MP3 files).

Lossy / Lossless: Digital sound formats are divided 
into two types: Lossy compression is that which actu-
ally removes some information in order to make 
the file easier to compress. Lossy compression is 
by far the most popular format, because it allows for 
much smaller file sizes. Virtually all lossy compres-
sion schemes, whether for audio or video, work by 
a principle called “perceptual coding.” This is the 
process of removing parts of the original data that 
the user will probably not even perceive anyway. The 
trick is to remove as little information as possible 
from the original audio sample and to make sure 
that which is removed is hardest to hear (frequencies 
above the range of human hearing, for example).

Lossless compression is just what it sounds like— a 
way of compressing music into a file that, when 
played back, is absolutely identical to the original. 
Not just “sounds the same,” but that is statistically 
identical. It was once only a viable option for profes-



reduction, but still a good space savings. A clip 
that is not quite so musically complex would com-
press further. The 128kbit MP3 cut the file down 
to 983 kilobytes, and 11:1 compression ratio.

Then we took a look at a spectrum analysis of the re-
sulting files. Note how lossless compression produces 
the exact same graph, while the MP3 file loses signal 
dramatically as frequency increases and drops off en-
tirely just over 16KHz. Increasing the bit rate can im-

prove this, but the only way to get a totally exact copy 
of the music is to use a lossless compression scheme.

Bit Rate: The bit rate of a digital file is defined as how 
many bits it uses up in a given interval of time. (An 
audio file is almost always measured in “kilobits per 
second.”) Typically, the higher the bit rate at which 
music is encoded, the better the sound is. A rate of 
128 kilobits/sec is extremely popular in online music 
downloading— legal and otherwise— because it offers 
a good compromise between sound quality and down-
load time. Here’s a little chart to give you an idea of 
how different bit rates compare to regular CD audio.

Bit rates lower than 128kb/sec are generally not suit-
able for CD or hard drive-based devices, but rates be-
tween 64 and 128 are great for devices with only 64 or 
128MB of memory where you want to pack on more 
songs, or even for streaming internet radio if the lis-
teners have broadband connections. Very low bit rates 
(below 64kbps) are almost totally unsuitable for music 
but compress voice fairly well and can be used for on-
line voice chat or streaming talk/news radio. Of course, 
there’s always the option of using a variable bit rate.

VBR & CBR: These common acronyms stand for Vari-
able Bit Rate and Constant Bit Rate, respectively. Con-
stant Bit Rate audio files are the most common— they 
use up the exact same amount of data from one mo-
ment to the next. If you have a 128kb/s CBR music 



of the sound wave for each of the 44,100 samples ev-
ery second. No wonder CD audio files are so big.

How much sample rate and bit depth is enough? 
Well, according to the Nyquist Theorem, you 
need twice as many samples per second as the fre-
quency you’re trying to digitize. Human hearing 
peaks out at around 20-24KHz, so it would stand to 
reason that we need a sample rate of 40-48KHz to 
reproduce the entire range of human hearing.

But that’s only half the story. It may only take two 
samples per sound wave to reproduce it digitally, 
but the quality of taking this minimum approach is 
less than desirable. Bumping it up to four samples 
or more per wave, however, creates truly compel-
ling audio. A sampling rate of 96KHz is used in the 
DVD-Audio standard and by most professional digital 
recording equipment. This allows four samples for 
each wave in the upper limit of human hearing, and 
six to twelve samples for waves in the 8-6KHz fre-
quency range, where most of the music we hear is.

Bit depth is pretty good at 16 bits per sample, which 
is most common, but most professional audio equip-
ment and the DVD-A standard use 24 bits per sample. 
More bits are good in audio for the same reason they’re 
good in graphics. 16-bit audio allows for 65,536 dif-
ferent “levels” per audio sample, while 24-bit boosts 
that fidelity to 16.7 million. This huge increase helps 

file, it will use 128kilobits to describe the audio in 
each second of the song, regardless of what sounds 
are playing that second or the complexity of the audio 
stream at the time. A Variable Bit Rate is a bit smarter. 
A VBR music file will use a lower bit rate in areas of 
the song that are simpler to compress accurately, and 
then higher bit rates in parts that require more bits to 
describe accurately. VBR audio files are often made 
with a certain quality in mind, rather than a certain bit 
rate, but it’s almost always true that, all things being 
equal, a VBR sound file will sound better than a CBR 
file of the same size. The problem with VBR is that it’s 
hard to stream over the Internet, because the amount 
of data that needs to come over your net connection is 
constantly changing from one moment to the next.

Sample Rate/Bit Depth: These are the most basic 
specifications of all digital audio files, compressed 
or not. Sample rate refers to how many times per sec-
ond the original waveform is translated into digital 
form. CD audio, for instance, is sampled at 44.1KHz. 
That means that the left and right channels are each 
sampled 44,100 times per second. Sampled into 
what? That’s where Bit depth comes in. This is how 
many bits are used to describe each of those samples. 
The more bits used to encode the file, the more ac-
curate the sample. CD audio is sampled at 16 bits, so 
there is a 16-bit number to describe the amplitude 

http://en.wikipedia.org/wiki/Nyquist_theorem


preserve nuances and overtones and prevents quan-
tization errors when mixing tracks, in much the 
same way as 24-bit color on your monitor prevents 
the banding artifacts prevalent with 16-bit color.

Dynamic Range: In layman’s terms, this is the range 
from the softest to the loudest sound a system can 
reproduce. Humans (especially children) can hear 
nearly 0 decibels and our pain threshold is up around 
120 decibels, so we can say that humans have a dy-
namic range of around 120dB. When talking about 
digital audio, you generally have to subtract the noise 
floor— or amount of noise during “silence”— from 
the maximum sound output the system is capable of 
producing. In the digital realm, it’s generally accepted 
that you get about 6dB of dynamic range for each bit 
of sample depth. An audio CD, which is 16-bit audio 
at 44.1KHz, would therefore have a dynamic range of 
around 96dB. This is one reason why professional au-
dio is usually 24-bit; the dynamic range of 144dB is be-
yond the human limit and suitable for almost anything.

The chart at right gives examples of common  
decibel levels:

DCT/iDCT: Short for Discrete Cosine Transform, DCT 
is a technique for representing waveform data, such 
as audio waves, as a weighted sum of cosines. iDCT 
is Inverse Discrete Cosine Transform, which is basically 
just a means of taking the weighted sum of cosine 

data and turning it back into a waveform. DCT and 
iDCT itself does not lose any data in the process, 
but it is an important foundation of most lossy com-
pression formats including most compressed audio, 
video, and the ubiquitous JPEG image format.

DRM: If you haven’t heard of DRM by now, you haven’t 
been reading the technology news for the past year or 
two. Short for Digital Rights Management, it’s a blanket 
term for technologies designed to reduce or eliminate 
digital content piracy. When it comes to audio files, 
DRM involves the ability to do things like disable 
playback on foreign or unlicensed machines, limit the 
transfer of a file to some devices, or prevent it from be-
ing burned to multiple CDs. There are many different 
DRM technologies with a wide variety of capabilities, 



was developed before content protection and online 
distribution of pirated music became an issue, and 
thus contains no DRM at all. This, along with the 
relative high speed of encoding and decoding, has 
made the format popular with end users, but not 
with record labels. None of the major for-pay online 
services use MP3 as their file format. You can read 
a lot more about MP3 at the Fraunhofer IIS page.

MP3 Pro: Thomson acquired this new format in 2001 
from its Swedish partner company 
Coding Technologies, who devel-
oped it when researching a hear-
ing device for the deaf. It claims 
to offer equal sound quality at half 

the bit rate of regular MP3. While this is certainly 
subjective, it does sound a lot better at very low bit 
rates (64kb/s and below). The chief advantage of MP3 
Pro is that it is backwards and forward compatible with 
MP3— a basic MP3 player will play a MP3 Pro file, just 
without the improvements in sound quality. But MP3 
Pro has no DRM capabilities either, so it shares in 
MP3’s inability to gain acceptance by music studios.

WAV: The WAV standard was developed by Micro-
soft and IBM nearly two decades ago, and is the 
de-facto standard for basic Windows sounds. WAV 
files are usually uncompressed, but a compressed 
standard achieves a 4:1 compression ration through 

and they’re not always such a bad thing. It’s possible 
for a format to have DRM capabilities that are not used, 
or for the content owners to set the DRM so “loose” 
that it’s just like having an unprotected file— so long 
as you don’t try to upload it to a thousand people on 
a file-sharing network. The MP3 file format contains 
no DRM capabilities, but almost all newer formats do.

ID3: The tag embedded within an MP3 file that in-
cludes fields for artist, album, title, track number, year, 
and a short comment. There is a slightly improved “v2” 
version of the ID3 tag that allows for longer comments 
and adds fields for composer, original artist, and a URL. 
Though ID3 specifically refers to MP3 files, there are 
similar tags embedded in most other digital media 
formats, many of which are more feature rich (some in-
clude room for lyrics, ratings, etc.). It’s not uncommon 
to hear people refer to them all as simply “ID3 Tags.”

The Major Audio Formats.
MP3: Contrary to what many people believe, this is 
not MPEG3 audio. It’s actually MPEG, Layer 3. It was 
developed in the late 80s by the Fraunhofer Institute 
in conjunction with the University of Erlangen. 
Today, the patent rights belong to Thomson and 
Fraunhofer IIS, and are granted by Thomson. Many 
people think MP3 is “free,” but a license is required 
to sell products that encode or decode MP3 as well as 
to broadcast commercial MP3 content. The standard 

http://www.codingtechnologies.com/
http://www.microsoft.com
http://www.microsoft.com
http://www.ibm.com
http://www.fraunhofer.de/fhg/EN/index.jsp
http://www.uni-erlangen.org/
http://www.thomson.net/EN/home
http://www.iis.fraunhofer.de/index.html
http://www.mp3licensing.com/
http://www.codingtechnologies.com/


an the lossy ADPCM (Adaptive Differential Pulse Code 
Modulation) scheme that drops each sample down 
from 16 bits to 4 bits. There are several other com-
pressed WAV formats, such as GSM, ALAW, and ULAW, 
but these are even less popular than ADPCM.

AAC: Short for Advanced Audio Coding, AAC has been 
part of the MPEG-2 spec ever since the Motion Pic-
ture Experts Group declared it standard in April of 
1997. It was developed by the Fraunhofer Institute in 
conjunction with companies like AT&T, Sony, and 
Dolby. Technically, the AAC format can support up 
to 48 full frequency sound channels, so 5.1 or 7.1 
sound is entirely possible. It also supports sample 
rates up to 96KHz, twice the maximum afforded 
by MP3. Recently, MPEG-4 AAC added a couple of 
technologies to the spec that improve quality at ex-
tremely low bit rates (think cell phones). At higher 
bit rates, though, it’s essentially the same as MPEG-2 
AAC. This is the format used for songs downloaded in 
the popular iTunes Music Store, but AAC does not 
have any real DRM of its own, so Apple uses its own 
DRM “wrapper,” called FairPlay, on iTunes songs.

WMA: Microsoft’s Windows Media Audio format 
has undergone many ma-
jor changes in the past few 
years, with drastic improve-

ments in quality, efficiency, and features. Today’s 
WMA9 technology includes four separate codecs:

• Windows Media Audio 9: Microsoft claims 
a 20% improvement in quality/bit rate over 
WMA8, but the big addition here is support for 
VBR encoding. Fortunately, you can decode 
WMA9 files with devices and software made to 
decode previous generations of WMA.

• Windows Media Audio 9 Professional: The 
Pro edition is similar to WMA9, but supports 
up to 24-bit/96KHz audio and sound formats 
up to 5.1 and even 7.1. One of its cool features 
is that the decoder will automatically adapt the 
audio material to whatever hardware you have. 
So if you try to play WMA9 Pro file that is 5.1 at 
24-bit/96KHz on sound hardware that can only 
do stereo 16-bit/48KHz, it will fold the sound 
down to that spec.

• Windows Media Audio 9 Lossless: This is 
a VBR-only codec that produces absolutely 
perfect, mathematically lossless copies of an 
original audio file, including 24-bit/96KHz and 
5.1 audio. The compression ratio isn’t nearly 
as high as with lossy compression, averaging 
from around 2:1 to 4:1 (depending on the com-
plexity of the source material.) This codec is 

http://www.chiariglione.org/mpeg/
http://www.chiariglione.org/mpeg/
http://www.att.com
http://www.sony.com
http://www.dolby.com
http://www.apple.com/itunes/
http://www.microsoft.com/windows/windowsmedia/default.aspx
http://www.microsoft.com/windows/windowsmedia/default.aspx


less for true lossless compression and RealAudio 
Multichannel for up to 5.1 audio, though these for-
mats require RealPlayer 10 or better for playback.

The Other Audio Formats.
Ogg Vorbis: Ogg Vorbis is similar to 
MP3 or AAC compression formats, 
but with one important difference. It 
is completely free, unpatented, and 
open-source. There are actually two 

terms here: Ogg is the file container that should one 
day contain both audio and video, while Vorbis is the 
actual audio compression designed to be contained 
within it. The .ogg container may embed other formats, 
though, like FLAC or Speex. This is important because 
the Vorbis compression scheme is optimized for music 
and general-purpose audio, not low-bit rate speech 
compression, and it has no lossless compression op-
tion. Vorbis supports 6-channel (5.1) audio, and is fairly 
well supported by software but almost unseen in the 
hardware player market. It’s royalty-free nature has 
made it popular with some game developers, though. 
It is used several PC games including Unreal Tourna-
ment 2003, Serious Sam: The Second Encounter, and 
Harry Potter and the Chamber of Secrets, to name a few. 

ATRAC: Sony’s ATRAC 
(Adaptive Transform 

Acoustic Coding) format is most widely used in its 

designed for professionals and audiophiles that 
want to archive perfect copies of their music.

• Windows Media Audio 9 Voice: This codec 
is optimized for extremely low bit rate files, 
like those that you would stream over a dial-up 
Internet connection or cell phone, or that you 
would use for real-time online voice chat. 

Note that just because a portable music device or piece 
of software can play back “Windows Media Audio,” that 
does not mean it can play the Professional, Lossless, 
or Voice formats. Those require their own decompres-
sors. The WMA format has robust DRM and, coupled 
with Microsoft’s influence and a reasonable royalty 
rate, has become quite popular among online music 
services. Napster, MusicMatch, BuyMusic.com, 
and Wal-Mart’s online music store all use WMA.

RealAudio: The RealAudio format from 
Real Networks started many years ago 
as a delivery mechanism for stream-
ing audio over the net, primarily with 

dial-up internet connections. Times have changed, 
of course, and the latest technology is much more 
robust. At bit rates less than 128kb/s, RealAudio 10 
uses its own proprietary compression technology. At 
higher bit rates, it uses MPEG-4 AAC. It’s backwards 
compatible with RealAudio 8 players, too. The new 
Real 10 platform also incorporates RealAudio Loss-

http://www.vorbis.com/
http://www.sony.net/Products/ATRAC3/index.html
http://www.napster.com
http://www.musicmatch.com
http://www.buymusic.com
http://musicdownloads.walmart.com/catalog/servlet/MainServlet
http://www.real.com
http://www.real.com
http://www.vorbis.com/
http://www.sony.net/Products/ATRAC3/index.html


MiniDisc and solid-state Walkman digital music 
players. The original ATRAC format is arguably not 
quite as good as a well-encoded MP3 file, though 
it has gone through several revisions. Newer Sony 
hardware, like most Clie PDAs, use the superior (and 
incompatible) ATRAC3 format. The latest format, 
ATRAC3plus, promises twice the efficiency of ATRAC3, 
but is only just now seeing widespread support with 
the release of the Hi-MD MiniDisc players. ATRAC 
works by splitting the sound signal into separate fre-
quency bands and compressing them separately. 

FLAC: (Free Lossless Audio 
Codec) FLAC is like Vorbis in 
that it is totally free, unpat-
ented, and open-source. As 
with other lossless compres-

sion formats, it produces rather large files, and in fact 
is not quite as efficient as some other lossless formats. 
For some users, being free and open-source outweigh 
whatever shortcomings the FLAC format may have. 

Speex: Another open-source, patent-free audio com-
pression format, Speex is targeted at compressing 

speech to very low bit 
rates— in the 2 to 44 
kilobit per second range. 
It includes lots of good 
features, such as packet 
loss concealment and 
voice activity detection, 
and offers a VBR mode 
as well as the ability to 
change bit rate on the fly. 

Shorten: Owned by 
Cambridge-based Soft-
Sound, Shorten is a pro-
prietary waveform coder 
that offers both lossless 
and lossy compression 

http://www.sonystyle.com/intershoproot/eCS/Store/en/imagesProducts/FlashDemo/ATRAC_2/site/index.html
http://www.sonystyle.com/intershoproot/eCS/Store/en/imagesProducts/FlashDemo/ATRAC_2/site/index.html
http://sonyelectronics.sonystyle.com/micros/clie/
http://flac.sourceforge.net/
http://www.speex.org/
http://www.softsound.com/Shorten.html
http://www.softsound.com/Shorten.html
http://flac.sourceforge.net/


B elieve it or not, this only scratches the surface 
of digital audio terminology and formats. There are 
dozens of other file formats and codecs out there, and 
certainly the lexicon of digital audio terminology would 
fill a dictionary. So what should you make of it all? 
Unfortunately, digital audio is more complicated than it 
has to be. Both the computer and CE industries would 
stand to gain from adopting more universal standards 
and working toward interoperability. Unfortunately, 
there are too many incompatible formats, too many 
exposed settings and important terms to learn, and too 
many companies trying to lock you into using their 
own tools. The only clear standard is the venerable 
MP3 file, which provides inferior quality compared 
to newer formats and lacks the DRM capabilities to 
make it viable for e-commerce. We expect something 
of a shakeout to happen over the next few years.  

modes. The lossy compression only offers compression 
ratios of 3:1 to 5:1, and is not very popular compared 
to more robust lossy compression schemes like MP3, 
AAC, or WMA. The lossless mode is a bit more popular 
among audio professionals and sound enthusiasts, with 
a typical compression ratio of about 2:1 for 16-bit audio.

Monkey’s Audio: One of the more popular lossless 
audio compression formats is the Monkey’s 
Audio Compressor, or MAC. We’re not mak-
ing this up. The FAQ makes mention of 
the name and file extension by saying, “In 
hindsight, maybe it’s a stupid name. Then 

again, maybe you just need to lighten up.” The compres-
sor can trade off encoding speed for compression ratio, 
though it’s always in the neighborhood of 1.5:1 to 3:1, 
depending on the source material. The source code 
is available, but there is a license agreement which 
states you can’t make commercial products with MAC 
unless you discuss terms with the developer first. 

What to make of all this.

http://www.monkeysaudio.com/index.html
http://www.monkeysaudio.com/index.html


Other iPod Resources.

Extreme iPod.com

Apple’s iPod site

iPod Hacks

iPoding

iPodlounge

iPod Infozone

MP3 at PC Mag.com

iPod Shopping

http://www.extremeipod.com
http://www.extremeipod.com
http://www.apple.com/ipod 
http://www.apple.com/ipod 
http://www.ipodhacks.com/
http://www.ipodhacks.com/
http://www.ipoding.com/
http://www.ipoding.com/
http://www.ipodlounge.com/
http://www.ipodlounge.com/
http://www.macspeedzone.com/html/hubs/central/other/ipod.html
http://www.macspeedzone.com/html/hubs/central/other/ipod.html
http://www.pcmag.com/category2/0,1738,2359,00.asp
http://www.pcmag.com/category2/0,1738,2359,00.asp
http://extremetech.shopping.com/xFS?FD=0&KW=ipod

